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Introduction

The Z-Write Concept
Every large writing project is made up of thousands of snippets of text.
In addition to the main text, there are notes you make to yourself,
various revisions, perhaps alternative chapters. There might be several
outlines, descriptions, pages of ideas and thoughts. A fiction writer will
have extensive biographies of various characters and plot strategies,
while a non-fiction writer has to deal with hundreds of resources, facts,
figures, contacts, and bibliographic details. Keeping track of all that
information is complicated.

Traditional word processors work in a linear style: chapter follows
chapter, and you must create new documents for every new kind of
information. You exchange the chaos of thousands of 3x5 notecards for
the chaos of hundreds of computer files.

Since books are written in a non-linear fashion, why not a non-linear
word processor? That’s the core of Z-Write: it allows you to store
hundreds of snippets of text in a single file!

A Z-Write document window.



8

Z-Write™ — User’s Guide

These snippets can be short notes, entire chapters, or revisions of your
entire project. Everything is convieniently at hand, ready for browsing
or editing. You can view, copy, and paste from one Section to another.
You can create as many Sections as you need, and you can organize
them in any manner that you’d like. Each Section can be as long as you
need.

This makes the process of sorting, finding, and remembering details a
billion times easier. You can use Z-Write’s Sections as a way to manage
multiple versions of some writing. If you’ve ever tried to keep three
versions of Chapter 7 in a traditional linear word processor file, you
know it’s not fun.

Limitations
Z-Write is not intended to completely replace your high-end word
processor. Z-Write is streamlined for writing and organizing. You won’t
find support for footnotes, WYSIWYG display, imported graphics,
tables, tabs, etc. The idea is that you’ll use Z-Write for writing and
brainstorming.  If you need high-end formatting features, you can copy
or export the final text to a full-featured word processor like Nisus
Writer or Microsoft Word.

With those limitations in mind, Z-Write has features writers will
appreciate. Unlike many “idea processors,” Z-Write is designed for
writing. Z-Write is simple and elegant, streamlined for getting your
project organized and finished. There are no limits to length or the
number of Sections. Z-Write makes it easy to combine, print, or export
only certain Sections. It always remembers where you left your cursor,
the document window size and position, even the text you had selected,
making it easy to continue right where you left off after a writing
session. It offers conveniences like reopening the last document you
were working on, and supports find and replace, case conversion,
glossaries, digital bookmarks (which allows you to jump to specific
places within your text, in any Section), powerful print headers and
footers, and several export options. In short, Z-Write is an elegant tool
you will find indispensable.
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Key Features
• Unique multi-section writing system
• Simple, elegant, and functional
• On-line instructions and “Hot Help” for button bar items
• Z-Write remembers your document’s window size, position, and
exactly where you were editing when you last saved

• Customizable: extensive Preference settings let you adjust Z-Write
to work the way you prefer

• Electronic Bookmarks — memorize locations in a document for
instant access

• Glossary — quickly insert memorized snippets of text
• View Windows — browse multiple Sections simultaneously
• Quickly imports an entire folder of text documents into a single Z-
Write document, ready for editing

• Export to HTML, RTF, and styled text
• Hypertext links between Sections
• Can insert a Section inside another upon printing or exporting
• Text conversion features — handy for formatting e-mails or text
brought from a PC

• Find and Replace
• Button bar
• Time/Date insert
• Word count and other statistics
• Can automatically “bullet,” number, or sort paragraphs
• Automatic “smart quote” feature
• Auto-save feature (you set the frequency in minutes)
• You can print or export a sublist of Sections
• Print preview
• Flexible print headers and footers with print variables (like total
number of pages within the document)

• Unique “auto-resize” feature which can enlarge or shrink type sizes
when printing

System Requirements
Z-Write requires a Power PC Macintosh, Mac OS 7.5 or better, any
version of QuickTime, a few megabytes of disk space, and 10MB of
available RAM. (Large documents require more RAM as do certain
features, such as Print Preview.)
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Installation
Z-Write does not require any special installation. Simply decompress
the archive and put the Z-Write folder wherever you’d like.

Updates
Stone Table Software is committed to high-quality software. We
continually update our products. Depending on where and when you
obtained Z-Write, there may be a more recent version posted on our
website. Visit http://www.designwrite.com/sts for the latest version.

Registration
Z-Write is commercial software and you must purchase a license to
continue using it. You are free to preview the software for two weeks
with no limitations. After two weeks, Z-Write will remind you to
register when you launch the program. After thirty days, Z-Write will
revert to a demonstration version which disables certain program
features, such as the ability to rearrange Sections.

Because Stone Table Software feels strongly that users should never be
prevented from accessing their data, you will always be able to open
and edit your Z-Write documents. We hope that users appreciate all
the effort involved in creating a program of Z-Write’s quality and don’t
abuse this feature. For specifics on the limitations of the demonstration
version of Z-Write, see the release notes accompanying the program.

Purchasing a License
Registering your copy of Z-Write is easy. You can pay for Z-Write with
a credit card via our website, or place your order via e-mail, fax, or
postal service. Included with the Z-Write package is a special program
called “Register” which will walk you through the purchase process.
Read the included documentation if you have questions.

Once we have received your payment, you will be sent an e-mail that
will include your registration code. Go to the Apple menu and choose
the “Registration Info…” item. That will display the following “Legal
Stuff” dialog:
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Click the “Register…” button and enter your name and registration
code in the “Register” dialog box. You must enter this code exactly as it
was sent to you — the red X will change to a green checkmark when
you enter a valid code. Click OK and you’re finished!

Important: Keep your code in a safe place in case you ever need it
again (like if you need to reinstall Z-Write on a new Mac or reformat
your hard drive).
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Using Z-Write

General Usage
Z-Write is simple to use. In general it works like most Macintosh word
processing applications. Selecting text, editing text, copy and paste,
drag-and-drop, changing type characteristics (boldface, size, etc.) all
function the way you’d expect.

Section List (left) and Main editing area.

When you create a new file, the main word processing window is
displayed. Z-Write uses an elegant dual-paned writing system. On the
left is a scrollable list of Section names. (New files have only one pre-
defined Section called “Default.” You can change the default name
within Preferences.) To the right of the Section List is a standard text
editing area. Any text you type is associated with the Section you have
selected on the left. (If no Section is selected, the editing area is
disabled.) When you click on a different Section, that Section’s text is
placed on the right for editing. Each Section can have as much text as
you’d like.

At the top of the window is a handy “button bar,” where you have tools
for quickly formatting your text, such as font and text size menus and
style buttons. If you point your mouse cursor at any of the buttons, a
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description of its use will appear in the “Hot Help” area below the
Section List at the bottom of the window.

If you select a different Section from the list on the left, the text for that
section is displayed on the right. You are free to edit and copy and
paste between sections. You can even drag text from other applications
into the editing area, and if you drag a selection to the desktop, Z-Write
will create a text clipping (if your operating system supports it).

At any time, you can add or delete Sections to your document. You can
create as many Sections as you like, but each must be uniquely named.
(Z-Write prevents you from entering the same name twice.) You can
write as much as you’d like in each Section. No matter how many
Sections you create, Z-Write saves the entire document as one
convenient file.

See “Working with Sections” for more details.

Keyboard Navigational Commands
Z-Write 1.1 supports the following keyboard commands for editing text:

Deleting:
[delete] - Deletes next character on the left or the selection
[shift-delete] - Deletes character to the right or the selection
[option-delete] - Deletes word to the left
[shift-option-delete] - Deletes word to the right

Movement:
[left/right arrow] - Moves cursor left/right one character
[up/down arrow] - Moves cursor up/down one line
[option up/down arrow] - Switches to next Section up/down
[option left/right arrow] - Moves one word left/right
[control left/right arrow] - Moves to next/previous paragraph
[control up/down arrow] - Jumps to beginning/end of doc

Help
Z-Write is a powerful word processor with many shortcuts and
innovative features. At any time you can access Z-Write’s on-line
documentation by pressing the Help key (if your keyboard has one),
choosing “Instructions” from the Mac OS Help menu, or holding down
the Option key while clicking on the “Hot Help” area at the bottom of a
document window.



14

Z-Write™ — User’s Guide

Hot Help
To help you learn the program and remind you about features rarely
used, Z-Write features Hot Help for most program commands. Simply
point to an item and Z-Write will display a short description of the
feature in the Hot Help area. For a document, this is the lower left
corner of the window. If you point at buttons or window elements, Z-
Write will tell you what they are for. In many dialog boxes, like
Preferences, Z-Write will display help text for each of the options in the
dialog box.

Checking Spelling
If you need a spelling checker and thesaurus, we highly recommend
Casady and Greene’s excellent SpellCatcher 8.x, which checks your
spelling as you type and works within any application (see http://
www.casadyg.com/products/spellcatcher/mac/default.html).

There is also the freeware spelling checker “Excalibur,” which works
with Z-Write via AppleEvents. You can download Excalibur at http://
www.eg.bucknell.edu/~excalibr/excalibur.html. It works, but the one
drawback with this method is that you lose any text formatting (such as
bold or font size change) you may have applied to your text. Users have
reported Newer Technology’s free SpellTools (http://newertech.com/
software/spelltools/index.html) also works well.

Finding and Replacing
Z-Write includes powerful find and replace capabilities. You can
specify whether Z-Write searches just the current Section or All
Sections. Within the Find/Replace dialog you can add special
characters to your search string, such as a tab or carriage return (end-
of-paragraph).

After completing a find or a replace, you can press Command-G to find
or replace again. Z-Write will continue the search from the cursor’s
current position.

If you choose “Replace All” from within the Find/Replace dialog, Z-
Write will replace every occurrence found in the Section or entire
document. Note the undo for “Replace All” only works within the
current Section, so make sure you really mean it! (As a safety
precaution, you can save just before doing a Replace All for all
Sections.) If you interrupt a Replace All (by pressing Command-period)
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Z-Write will stop replacing wherever it is, leaving some occurrences
replaced and others unchanged.

You can also choose the “Find” button on the button bar. Holding down
the Option key while clicking the button acts as a “Find Again”
(Command-G) command.

Bookmarks
One of Z-Write’s coolest features is its support for electronic
bookmarks. You can place a bookmark anywhere in your text using the
Insert Bookmark command. When you do that, Z-Write prompts you
for a bookmark name. Use any text you’d like to describe the bookmark
(like “plot problems”). Then Z-Write will insert “<bookmark plot
problems>” into your text at the cursor position.

Note: Even though bookmark tags are visible within Z-Write, they will
not show up when your document is printed or exported.

To jump to a specific bookmark, choose that boomark’s name from
either the Bookmarks menu or the Bookmark popup menu on the
button bar. (You can also select bookmarks from the contextual menu
that pops up when you Control-click the text editing area.) To jump to
the next bookmark in your document, press Command-J or choose the
Jump to Next Bookmark command.

Note: Z-Write’s bookmarks must follow the bookmark pattern exactly
or Z-Write won’t be able to find it. You can type them in manually, but
using the Insert Bookmark command is easier. When you delete or
change a bookmark manually, Z-Write needs to know to update your
bookmarks. Use the “Rescan for Bookmarks” command on the Utilities
menu to force Z-Write to update its list of bookmarks. For example, if
you accidentally typed “plor problems” instead of “plot problems”
when you created your bookmark, you could just edit the text manually
and choose “Rescan” to have Z-Write learn the new name.

Deleting Bookmarks
You may delete bookmarks manually or you may use the “Clear
Bookmarks” menu commands. You have the choice of clearing just the
bookmarks in the current Section, or erasing all bookmarks in your
document. If you erase bookmarks manually, you must use the “Rescan
for Bookmarks” command for Z-Write to update its list of bookmarks.
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Hyperlinks
A new feature of Z-Write 1.1 is the ability to add hyperlinks between
Sections. Hyperlinks can aid in navigation of a complex document, and
when you export your text to HTML, the links are converted to web-
ready hyperlinks.

The simplest way to add a hyperlink to a Section is to drag from the
Section List the Section Name you wish to link to, into your current
Section. Z-Write will insert a Link Tag similar to the following:

<link sectionname>

Of course, “sectionname” would be the name of the Section you’d
dragged.

There is also a new “Insert Link” menu command (Utilities > Insert >
Section/Link Tag) which will prompt you for the kind of tag you’d like
to insert and allow you to choose a Section from a popup menu.
Whenever you see a Link Tag like the above, you can jump to it by
clicking on its leftmost point (the “<” character) while holding down
the Command key.

You may also insert links to bookmarks as well as Sections. Just replace
the “sectionname” above with the bookmark name. You may have Z-
Write generate the Link Tag for you by holding down the Option key
while selecting a bookmark from the bookmark menu.

Currently, bookmark links are deleted when exporting to HTML, but in
the future Z-Write will generate HTML to use these tags as anchors.
Hyperlink tags are automatically deleted when you export to text or
RTF or print your document.
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Section Insertion
Also new to Z-Write 1.1 is the abilty to insert one Section inside another
via a special Insert Tag. It looks and works similar to the Link Tag,
except that when you print or export, the full text of the Section you
name replaces the tag. For instance, you could have a Section with the
following inside it:

<insert chapter 1>
<insert chapter 2>
<insert chapter 3>
<insert chapter 4>

When you printed this Section, it would contain the first four chapters
of your book. Then you could have another Section with the following:

<insert chapter 1>
<insert chapter 2b>
<insert chapter 3b>
<insert chapter 4>

This would also print your book, except that since it inserts chapters
“2b” and “3b,” the book would be a little different.

You could even use this to include alternate text within the middle of a
Section. For instance, let’s say you use Z-Write to write a sales letter.
The bulk of the letter would be the same, but the middle paragraph
would be customized, depending on if it’s going to a national contact or
a state contact. Instead of writing the letter twice, create one letter and
insert in the appropriate Section. That inserted Section would only
have the one paragraph that’s different.

This is an extremely powerful feature. Experiment with it to see what it
can do.

To insert an Insert Tag into your document, hold down the Option key
as you drag a Section Name into the current Section. Instead of
inserting a Link Tag, Z-Write will put in an Insert Tag. You can also
add an Insert Tag via the “Insert Tag” menu command.
Command-clicking at the start of an Insert Tag will jump you to that
Section, just like a hyperlink.
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Document without and with the Button Bar active.

The Button Bar
At the top of the main Z-Write window is a handy row of buttons for
frequently used options. If you prefer not to have the button bar, you
can hide it by pressing Command-Y (or choosing “Hide Buttonbar”
from the Edit menu). You can bring it back by using the same
command again (“Show Buttonbar”). Z-Write will remember the state
(on or off) of your document when you save it. If you prefer to not have
the button bar for new documents, you can set that option within Z-
Write’s Preferences.

Note: Below the Section List are several buttons for manipulating
Sections. These buttons are displayed even when the button bar at the
top is turned off. See “Working with Sections” for more information.

Briefly, here is what each button on the button bar does.

Save Button

When this button is active, you have modified your document and it
needs to be saved. Clicking the button will save your document. If you
haven’t saved the document previously, Z-Write will prompt you to
name the file and save it in the appropriate location on your hard drive.
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Print Button

This button will print the current Section. Holding down the Option
key while clicking the button will prompt you to select which Sections
to print.

Convert Case

On the button bar is a handy popup menu for converting the case of
selected text. You can quickly make the text uppercase, lowercase,
capitalize each word in the selection (titlecase), or capitalize sentences
(sentencecase). This button is disabled if you have no text selected.

Adding Bullets, Numbers, or Sorting Paragraphs

Next to the Convert Case button is the Paragraph button. It will let you
add bullets or numbers to each of the selected paragraphs. This is
handy if you’re creating a list of items. Type in them in, select the whole
bunch, and choose “Bullet Paragraphs” or “Number Paragraphs” from
the Paragraph popup. You can also sort the selected paragraphs
alphabetically (A-Z) or in reverse order (Z-A). This button is disabled if
you have no text selected.

Info Button

If you want to see your document’s statistics, press Command-I or click
the “Info” button. Z-Write will display a floating window showing the
number of characters, words, sentences, and paragraphs in your
selection, Section, and entire document. (You may leave this window
open while you type, but its contents are not updated until you click the
Info button or press Command-I again.) Z-Write will remember the
location of Statistics window.
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Find Button

This button activates Find and Replace command described earlier.
Holding down the Option key while clicking the button acts as a “Find
Again” (Command-G) command.

Bookmark Button

This button displays a popup menu of bookmarks in your document.
Choose one to jump to that location. If you have no bookmarks in your
document, this button will be disabled.

Glossary Button

This button lets you select pre-defined glossary items and insert their
text into your document at the cursor position. See the “Glossary”
description for more information about glossaries. If you have no
glossaries, this button will be disabled.

Typestyle Buttons

Also on the button bar are standard typestyle buttons (plain, bold,
italic, underline) and a color popup, which lets you color the selected
text. There are several common colors predefined, but if you choose
“Other” from the menu you are prompted with a standard Apple color
picker so you can select your own. Next to these buttons are the
standard Font and Type Size menus which will set the typeface and size
of the selected text.

Copying and Pasting Attributes
On the Edit menu you will find the Copy Attributes and Paste
Attributes commands. They will memorize the formatting of a
selection of text: font, size, color, and other features are saved and can
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be “pasted” onto another selection without replacing the text. This is a
great way to keep headings consistent. Simply format the first heading
the way you’d like it to appear, then copy the attributes of it and paste
the attributes onto the other headings. They will each take on the size
and style of the first, but their text will not change.

Special Formatting Commands
On the Insert menu there are two special printing options, Insert Page
Break and Insert Center Tag. On screen these show up as special codes,
<N> and <C>, respectively. These commands only work when you
print: the Print Preview feature will show you how these effects will
look when printed.

The Center Tag will center the text of the current line. It does not work
with an entire paragraph — it is designed for headlines you wish to be
centered. The Page Break command forces a new page to begin on the
line where you put the tag. Both of these tags are only valid at the
beginning of a line; the menu commands are disabled when your text
cursor is anywhere else. If you manually type them in elsewhere, they
will show up as text within your document.

Just like with Bookmark codes, Center and Page Break tags are
removed when your document is exported.

The Edit Glossary dialog.

Glossaries
Z-Write allows you to store snippets of text into glossary entries.
Glossaries are cool because you can type just the name of an entry and
Z-Write will “type” in the predefined text for you. This is great for



22

Z-Write™ — User’s Guide

frequently used text like your name and address, letter templates,
abbreviations, etc.

You define glossary items with the “Edit Glossary Items” menu
command (on the Utilities menu). Each glossary entry has a unique
name. To edit the entry, select it from the list at the left and edit the
name or the entry’s text on right. To delete an entry, select it from the
list and click the “Delete” button. To create a new entry, click the “New”
button and type in a name on the right.

You can put any text you want into a glossary item, including carriage
returns. There are two special commands you can insert into a glossary
item: #d and #t. These characters are replaced by the current date and
time (in the format specified within preferences). This allows you to
create a custom date and time stamp. You can even map your glossary
item to one of Z-Write’s date/time insert commands to customize the
way dates appear when inserted (see “Preferences” for more details on
this powerful feature).

To activate a glossary entry you can just type the name and Z-Write will
automatically expand it. (If this bothers you, you can turn this
automatic expansion off within Preferences.) Z-Write normally
expands a glossary item when you type a space or other end-of-word
character (like a return). If you hold down the Shift key as you type a
space, you can prevent Z-Write from expanding your glossary item.

Other methods to activate a glossary are to either choose the glossary’s
name from a menu on the button bar or type the name of the item and
press Option-Tab. (The text cursor must either be exactly to the right of
the glossary name or the glossary name must be highlighted for the
Option-Tab method to work.) For example, in my Z-Write if I type mbz
and press Option-Tab Z-Write will replace mbz with Marc Zeedar.

You also can quickly choose one of the first ten glossary items by
holding down the Control key and pressing a number key (numbers
1...0 correspond to glossary items 1 through 10), or use the contextual
menu that pops up when you Control-click in the text editing area.
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Working with Sections
Sections are the most significant feature of Z-Write. You can create as
many Sections as you want and they can be of any length. Sections
could correspond to chapters in a book, or they could be sub-chapters;
whatever you want. All commands for working with Sections are found
on the Section Tools menu, the buttons below the Section List, or on
the contextual menu that pops up when you Control-click the Section
List. Note that the Section Buttons will enable or disable themselves as
appropriate: for instance, you cannot duplicate a Section when no
Section is selected.

Hiding/Showing the Section List
You can hide the Section List by clicking (not dragging) on the Move
Bar between the Section List and the text editing area. This will
collapse the Section List so the Move Bar is at the far left, giving you
the full window for typing. While the List is hidden, you can still switch
between Sections via keyboard commands (option-up/down arrow),
and you can still manipulate Sections (rename, duplicate, etc.) via
keyboard commands or menus. To make the Section List visible again,
click on the move bar at the far left of the window.

Section Toggle
You can jump between the current Section and the last Section you
were in by pressing the Escape key. Pressing it a second time takes you
back to the original Section. This is useful if you’re editing two Sections
at the same time.

Adding a Section
To create a new Section, click on the New Section button or choose Add
Section from the Utilities menu. Z-Write will prompt you to name the
Section. Section names can be anything you’d like, but each must have
a unique name (Z-Write won’t let you enter a duplicate name).

Renaming a Section
If you’d like to rename a Section, simply double-click on the name,
choose the “Rename Section” menu item (Command-R), or click the
rename button. Z-Write will display a dialog box where you can edit the
name. Z-Write will not let you name two Sections identically.

Duplicating a Section
You can duplicate an existing Section with the Duplicate command
(Z-Write will append “copy” and/or a number on the end to distinguish
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it from the original) or button. This is handy for rewrites and alternate
versions.

Merging Sections
When you choose the “Merge Sections” command or click the Merge
Sections button, Z-Write will prompt you with the “Select Sections”
dialog box. Sections with a round bullet in the “On” column will be
merged into a single Section. Sections are always combined into the
topmost selection and always in the order they appear in the document.

The Rearrange Sections dialog.

Rearranging Sections
You can rearrange the order Sections appear in the Section List via the
“Rearrange Sections” command or button. In the resulting dialog box
you will find a list of Sections on the left. You can select one or more
Section names and click the Move Up or Move Down buttons to move
the items up or down a row. If you wish to move the items you have
selected to the very top or bottom of the list, you can click the “Move to
Top” or “Move to Bottom” buttons.
You will also find Sort and Revert buttons. Revert returns your
Sections into the original order before you changed them, and Sort will
alphabetize your list of Sections. (If you hold down the Option key
when clicking Sort the order will be reversed, Z-A.)
Selecting items in the list works as standard on the Macintosh: clicking
selects only the line you click on, Shift-clicking selects a continous
range from where you clicked first, and Command-clicking let’s you
select items non-contiguously. For instance, to select two Sections not
next to each other, hold down the Command key while clicking on
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them. To select two items and everything between the two, click on the
first one and then the second while holding down the Shift key.
There are also keyboard shortcuts you may use instead of the buttons.
The up/down arrow keys move the selected items up or down one row.
Option-up/down arrow moves the selected items to the top or bottom
of the list.

Deleting a Section
To delete a Section, choose the “Remove Section” command or click the
trash can icon. If the Section contains text, Z-Write will confirm your
request before removing the Section. There is no undo, so be sure you
are removing the correct Section. (If you hold down the Option key
when clicking the trash can, Z-Write won’t bother to confirm your
delete request -- handy if you’re wanting to delete a number of Sections
and you’re sure of what you’re doing.)

Moving Between Sections
To move between Sections quickly, you can use Option-Arrow Up and
Option-Arrow Down to move up or down the list of Sections. This
works even when the Section List is hidden.

View Windows
While you are working you might find it would be nice to see a different
Section than the one you’re currently working in. Z-Write has a unique
feature: it lets you open Sections in separate “read-only” windows. You
cannot edit text within a View Window — but you can select and drag
text from it into your main window.

To open a Section in a View Window, simply “Open Section as View
Window” from the Section Tools menu, or Option-doubleclick on the
Section’s name. The Section name will be displayed in italics to show
you that it’s open in a View Window. The View Window is named
“Document Name:Section Name.” This allows you to quickly see which
View Windows belong to which Z-Write documents and which Section
is displayed. You will note the crossed-out pencil icon on the View
window reminds you that you can’t edit text in a View window. To edit
it, select the Section within the main Z-Write document window and
edit it there. (Editing a Section won’t automatically update its View
window — you must bring the View window to the front to display its
current text.)
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Window Menu
If you have several documents open or more than one View Window
open, use Z-Write’s Window menu to bring the window you select to
the front.
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Preferences

Z-Write is customizable to the way you work via preference settings.
You access the Preferences window via the Preferences command on
the File menu.

The Preferences window is divided into several tabbed panes, with each
panel allowing you to change various settings. These are briefly
explained within the “hothelp” feature within the dialog box, but here’s
more detail about each option.

General panel of the preferences dialog.

General Preferences
The General area lets you set various preferences for how Z-Write
operates. These options apply to all documents.

Tab Key
Unlike some word processors, Z-Write does not support tabs or tables.
To align text you can use a monospaced font (like Monaco) and use
spaces. When you press the tab key or import text containing tabs,
Z-Write will replace the tab with spaces. This is where you specify how
many spaces Z-Write uses in place of each tab character.

Autosave
Use this feature to have Z-Write automatically save your document at
regular intervals. You set the time between saves in minutes. Set it to
zero if you don’t want Z-Write to save your document automatically.
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Show Seconds on Clock
Set this if you want the clock in the lower right corner of documents to
display seconds. (On slower Macs, updating the clock less frequently
can speed operations.)

Smart Quotes
Here you can turn on Z-Write’s “Smart Quotes” feature. Smart quotes
are sometimes called curly quotes, since they curl in and out depending
on if they are at the beginning or ending of a phrase. Smart quotes give
your work a more “typeset” look, but they aren’t always compatible
across platforms. On Macs you can type curly left and right
doublequotes with Option-[ and Option-Shift-[, but that’s not the
easiest. Z-Write will replace standard quotes with curly quotes as you
type if you turn on the “Automatic Smart Quotes” feature. If Z-Write
types the curly quote in the wrong direction (which can happen if Z-
Write is unsure whether you’re at the beginning of a phrase or not),
don’t panic — just press the same quote key again and Z-Write will just
change the quote’s direction. (You can also convert between smart and
straight quotes via the commands on the convert menu — useful for
text you’ve already typed or you’re preparing to e-mail.)

Auto-Expand Glossary Items
By default Z-Write will automatically expand glossary items when you
type the item’s name. If you use an ordinary word as a glossary item
name, however, this could prove awkward. Therefore Z-Write gives you
the ability to turn off auto-expansion with this setting.

Date/Time Formats
Since Z-Write has handy tools for allowing you to insert the Date and
Time within your document (such as clicking on the document’s clock
in the lower right corner), it allows you to set the format used (such as
“7/4/99” versus “Sunday, July 4, 1999”). In fact, Z-Write lets you pick
two formats: a primary and a secondary. If you Option-click the date or
time clocks (or hold down Option while you choose Insert Date or
Insert Time from the Utilities menu) Z-Write will use the alternate
format.

A powerful secondary feature of this is that you can map Glossary items
to a Secondary format. Simply choose the glossary name from the
popup menus to assign it to that function. This is mainly for creating
custom date/time stamps. For instance, you could have a stamp that
prints out “Modified Wednesday, July 7, 1999 at 9:16:31 PM.” Rather
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than piece that together with several clicks of the mouse and some
typing, simple create a glossary item that reads like this: “Modified #d
at #t.” When you call the glossary item, Z-Write will replace the “#d”
with the primary date and “#t” with the primary time. Once you’ve
mapped a glossary item to, for example, the secondary date function,
option-clicking the date would execute your glossary (instead of the
regular date routine).

Spelling Checker
Since Z-Write uses the free Excalibur spelling checker, you must have
downloaded and installed it for Z-Write to allow the checking of
spelling. To prevent you from selecting spelling without installing
Excalibur, you must enable spelling within the Preferences dialog
before the Check Spelling command is available. You only have to do
this once. There’s a handy button within the window to copy the
Excalibur URL to the clipboard for you so you can visit the website at
your convenience.

Printing Options
The Printing tab of the Preferences dialog lets you modify Z-Write’s
printing options.

Important: If you are using a Default Template, printing options
affect only the current document. To set default printing settings for
new documents, change the settings within your Default Template file.
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Margins
This is where you specify the top, bottom, left, and right margins for
your document. Measurements are in inches.

Header/Footer
The “Edit Header/Footer” button allows you to customize the Header
and Footer of the current document. If no document is open, editing
this will set the Default Header and Footer, which are used for all new
documents if you are not using a Default Template (the Header and
Footer set in the Default Template takes priority). (See the “Headers
and Footers” section for specific details.) You can also turn the header
and footer off or on here.

Line Spacing
Z-Write also lets you set the leading, or line spacing (the space between
lines of type). By default Z-Write uses the typesetting standard of 120%
(so 12-point text prints with 14.4 points of leading). This is a line
spacing of one. You can set your line spacing to 1.5 (150%), 2 (200%),
or 3 (300%). Note that this setting is global to the entire document: it
affects everything that is printed. There is no way to set a particular
paragraph to a different amount of leading.

Z-Write uses proportional leading, so if you make some text in the
middle of a paragraph extra-large, the leading will be different for that
line.

Sections Start On New Page
This option automatically puts in a page break at the beginning of a
Section when you are printing multiple Sections. (You can manually
insert page breaks wherever you want with the Insert Page Break menu
command.)

Auto-Resize
The most innovative print feature of Z-Write is the “Auto-Resize”
option. This allows you to enter in a number (in typeface points), and
Z-Write will resize all text in your document by the specified amount. If
you enter a positive number, the text is enlarged. If you enter a
negative number, the text is shrunk. For example, a “-2” would make
all 14-point text print as 12-point, and 18-point subheads would print
as 16-point.
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The advantage of Auto-Resize is that it allows you to edit your text at a
large, readable size, then print it at a more appropriate 10- or 12-point.
This is better than using the percentage reduction feature of your print
driver, as that reduces the entire page, giving you distorted margins. Z-
Write recomposes your document at print time at the new size, so it’s
also great for making more text fit on fewer pages.

Document
The settings here are used for all new documents.

Default Font, Size, and Section Name
Here you can specify the default font and font size Z-Write uses for new
documents. There’s also a place where you can put the default name for
the Section when Z-Write creates a new document. (By default this is
“Default” but you can change it to whatever you want.)

The default font and size set here are used when you use the “Set all
text to default font” menu command.

Buttonbar Visible
Set this if you want new documents to have a buttonbar or not. This
only affects new documents. Z-Write will remember the buttonbar
state for each document when it is saved.

On Launch
Within this area you can specify what Z-Write does when launched.
Check the “Do nothing” radio button if you don’t want Z-Write to do
anything. Check “Open blank document” if you want Z-Write to open
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an empty, untitled document. You can have Z-Write reopen the last file
you were working with by choosing the “Open last file” option.

Templates
Template files are standard Z-Write documents. Z-Write will simply
make a duplicate of the file you specify and open it as an untitled
document. Why is this good?

For instance, let’s say you like to write short stories and you’ve got a
nice Z-Write document with certain common sections you need for
your stories. Tell Z-Write to open it as a template — use the Open
Template menu — and Z-Write will make a blank copy of it ready for a
new story.

While a default font is nice, sometimes you’d prefer more control over
how Z-Write creates new documents. If you define a Default Template
file — a Z-Write document with whatever settings, text, and Sections
you’d like — Z-Write will automatically create a duplicate whenever
you select “New” from the File menu.

The Default Template document is a file within the Templates folder
inside your Z-Write folder. Simply open (double-click) the file to
change it to suit your needs. For instance, one user had a large monitor
and wanted Z-Write documents by default to open to the full size of his
screen. By saving the Default Template with a larger window, all new
documents open at the new size.
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HTML
There currently is only one option to set on the HTML panel: you can
set the Creator type of exported HTML files. The Mac OS uses a unique
code (called the Creator type) to identify which program created a file.
(That’s how it knows to open Simpletext when you click on a
Simpletext document.)

Since Z-Write can generate HTML files, it can be helpful to have Z-
Write make the files match the Creator of an Internet program of your
choosing. This could be your preferred web browser, such as Internet
Explorer, or perhaps an HTML editor like Adobe GoLive.

Z-Write knows the Creator codes of several popular programs by
default and you can choose them from the popup menu. You may also
choose the “Select an HTML Editor...” option to choose any application
installed on your computer. Once you have set this setting, Z-Write will
generate HTML that can be opened in that application simply by
double-clicking on them in the Finder.
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Printing

Z-Write has a powerful Print Preview feature. This allows you to see
your document on screen exactly as it will be printed without wasting
paper. You can print a single Section or a group of Sections. When you
choose the “Print Sections...” command from the file menu, you are
presented with the “Select Sections” dialog. Click on the Sections you
wish to print (Section names with a round bullet next to them will
print). Sections always print in the same order as they appear in the
document.

Print Preview
Within the Print Preview window, you can move between pages with
the buttons on the screen, or use the left and right arrow keys. Holding
down the Option key while clicking the Next or Previous page buttons
or using an arrow key jumps you ten pages forward or backward. There
are also buttons that take you to the first or last page of the document.

You have the option of turning the print header or footer on or off.
When you are ready to print, press the Print button.

Warning: Print Preview uses a considerable amount of memory.
(There’s no way around this; Z-Write essentially must draw the entire
document in memory in order to show it to you.) You may need to
allocate more RAM to Z-Write if you are printing long documents or
many Sections. For instance, one of my novels is a 315K Z-Write
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document. I had to increase Z-Write’s memory to nearly 20MB before I
could print the entire thing at once! (Another solution is to print fewer
Sections at once.)

Headers and Footers
Z-Write supports flexible headers and footers that appear when your
document is printed. Headers and footers can be any text you want,
and you have the ability to specify the font, text size, color, and various
style options for the text. You also can add a divider line which
separates the header/footer from the body text, and you can set the
thickness of the line.

Note: Z-Write’s headers and footers always print centered within the
top and bottom margins you’ve selected, so make sure you leave
enough room for them to fit!

You edit headers and footers within this dialog.

While the header and footer text is limited to one line and one style of
attributes (font, size, color, etc.), you have three alignment options. By
default Z-Write flushes your text to the left. If you press the Tab key, Z-
Write will type in <TAB> within the text line. This is a special code that
Z-Write uses so you can see you’ve typed a tab (since tabs are invisible).
Just like tabs in a regular word processor can align text in various
ways, these special header/footer tabs will align your text.
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The first bit of text you type is flushed left. After the first <TAB>,
however, the next bit is centered. After another <TAB>, the third bit is
flushed right. This allows you to easily create a header with some text
on the left, some centered, and some aligned on the right! If you wish
your header to be only flushed right or centered, simply enter the
appropriate number of <TAB>s (one for centering, two for flushed
right) and no text before them. (See the examples below for more.)

Z-Write’s headers and footers also support print variables. These are
very cool tags that allow you to insert special information that isn’t
known until print time (like the name of the current Section being
printed, or the length of the document). The following variables are
supported (which are replaced at print time):

#d (print date)
#t (print time)
#p (current page number)
## (total pages being printed)-
#s (name of the current Section)

You can type these codes manually, or you can use the handy popup
menu in the Edit Header/Footer dialog box. The following are some
examples of headers/footers:

Example 1: The Great Novel<TAB>#s<TAB>#d
Prints like this: The Great Novel Chapter One 10/04/99

Example 2: <TAB><TAB>Page #p of ##
Prints like this: Page 7 of 29

Note that the Total Pages code is the total of pages being currently
printed, not necessarily the length of your entire document. If you’re
only printing one Section, it’s the length of that Section.

As you type or change settings within your header or footer, the result
is graphically previewed within the dialog box.
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Importing Text

To make it easier to bring in your existing writing, Z-Write includes
some tools to import your files into a Z-Write document. At this time,
Z-Write will only import plain text files or Simpletext-style styled text
files. (To bring in text from other word processing formats, you can
copy and paste your text into Z-Write, or export it to text and import
the text file.)

Importing a File
To bring in a single file as a new document you can just open it within
Z-Write. Z-Write will convert it and place the text in the first Section of
a new document. If you’d like to add a file to an existing Z-Write
document, use the “Import File” command on the File menu. This will
add a new Section with the name of the imported file.

Importing a Folder
If you have many files (i.e. dozens of files associated with a novel), you
can import them all at once with the “Import Folder” command. This
will prompt you to choose a folder and it will import all importable
documents inside it.

If you have no document open, this command will create a new
document with a Section for each file (the Sections will be named with
the filenames of the imported files). If you have a document open, the
new Sections will be added to the existing document.

Note that the Import Folder command does not support sub-folders;
that is, it does not look inside folders inside the folder you choose. It
will also simply skip any invalid (unopenable) files it finds.
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Exporting Text

Z-Write is designed as a research and writing tool. For final
production, you’ll probably want to export the text you’ve created in Z-
Write in a format other programs support. Z-Write allows you to export
its text in one of three formats: styled text (Macintosh “Simpletext”
format, readable by nearly any Mac program), HTML, and RTF (Rich
Text Format). RTF is readable by many word processors such as
Microsoft Word. You can also copy and paste text from Z-Write into
other programs, and vice versa. Z-Write also supports “text clippings”
— drag some text to your desktop to create a clipping file, or drag a
clipping file into your document to import it.

With all of the export options you are presented with Z-Write’s
standard “Select Sections” dialog which allows you to pick which
Sections you wish to export (Sections marked “On” will be included in
your export). If you choose multiple Sections, the text for each Section
is combined into a single file. The text for each Section is labeled with
“Section: Section Name” so you can easily find the various Sections.

HTML Export
HTML export is a little more complicated. You can create a single file
or export each selected Section as a separate file. If you choose the
latter option (multiple files), you can have Z-Write generate a TOC
(Table of Contents) file. This is a very basic HTML document with the
title of your document and bulleted list of documents. Each of these is
the name of a Section and is hotlinked to that document. The
documents themselves are linked to each other via “Previous” and
“Next” buttons, and to the TOC document via a “Contents” link. This
makes it easy to put your document on the Web. If you’d like to
enhance the look of the basic HTML documents Z-Write creates, you
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can edit the files within an HTML editor like Adobe PageMill or by
hand if you know HTML. (Remember, you can set Z-Write to make
exported HTML files have the same Creator type as the HTML editor of
your choice. See the HTML panel within Preferences for more.)

When you export any HTML there are two settings that effect the kind
of HTML generated. You can set Z-Write to use all uppercase or
lowercase HTML codes. This has no effect on performance or quality —
it’s simply a subjective issue for people who like to edit HTML by hand.
You can also set whether or not Z-Write uses FONT tags to preserve
font information. If you turn this option on, the document should look
the same within your browser as within Z-Write. If you’re planning on
publishing the document on the Web and you’ve used fonts others
viewing the document may not have, it might be better to turn this
option off (meaning the document will be displayed with whatever
default font the user has set for their browser).

Special Conversions
Note that Z-Write automatically handles several special conversion
issues when you export to HTML. For instance, Link Tags are
converted to HTML links if you export to multiple files. If you export to
a single file, Link Tags are deleted. (At this time, Bookmarks and
Bookmark Links are not converted but simply deleted.) Center Tags
are converted to <CENTER> HTML tags, and New Page Tags are
converted to <HR> (horizontal rule) divider HTML tags.

Z-Write will also make any URLs it finds “hot” on export. That is, if you
include a URL like http://www.apple.com or stevej@apple.com it will
appear as an HTML link. (Note that for a web or FTP site, you must
include the “http://” or “ftp://” designation or Z-Write won’t be able to
detect it as a URL.)

Rich Text Format (RTF) Export
Rich Text Format is a text-based cross-platform format that preserves
text formatting. Most word processors can interpret RTF. If someone
would like you to send them a Microsoft Word file, RTF is an excellent
substitute.

There are no options for RTF Export. Simply select the Sections you’d
like to export and enter the filename in the save dialog.
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About Stone Table Software

Stone Table Software released their first product, the popular freeware
graphics utility ScanCalc, in 1996. The company was founded by Marc
Zeedar, a graphic designer, freelance writer, and Mac enthusiast, with
the idea of creating simple, innovative, useful tools that follow the
Macintosh Way.

In 2000 STS released their flagship product, Z-Write, a word processor
for creative writers with several unique and innovative features.
Z-Write is garnering praise and sighs of relief from writers around the
globe.

In addition to Mac programming, Marc is a columnist for
MacOpinion.com, runs a graphic design studio, DesignWrite, and is
actively writing two novels. Stone Table Software is based in Northern
California, where Marc lives with his cats, Mischief and Mayhem.
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